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Important Security Information
Improper configuration of the Cisco CTE 1400 can result in a security risk. Before you deploy the C
CTE 1400, verify the configuration as follows:

• Verify that the CTE does not have access to protected intranet sites.

By default, the CTE proxies only the web pages it has transformed in order to prevent acces
protected servers that are on the same subnet as the CTE. If you choose to override that defa
described in the“Configuring the Cisco CTE 1400 to Proxy All Web Pages” section on page 7, do
not put the CTE on the same subnet as protected servers.

Note If you configure the CTE to proxy all web pages, the CTE provides access to computers
on the same subnet as the web servers configured to work with the CTE. For example
suppose a CTE has an external IP address of 24.221.1.1 and an internal IP address o
192.168.1.31. On the same subnet, you have an intranet server, protected from outsid
access, with an IP address of 192.168.1.20. It is possible to access all ports on the
protected intranet server through the CTE by using the URL
http://24.221.1.1/http://192.168.1.20.

• Verify that port 9001 is not accessible from outside of your firewall.

The CTE communicates with Design Studio through port 9001 using clear-text transmissions
assure secure operations, you must block access to CTE port 9001 from outside of your firew

Important Information for Design Studio Users
When you complete work on the projects in a configuration file and are ready to put the file into
production, you must publish the configuration file to the Cisco CTE 1400. Only one configuration
can reside on a CTE at a time: The configuration file that you publish replaces the configuration 
previously in effect on the CTE.

We recommend that you follow these guidelines when working with Design Studio configuration f

• Save your work on your PC often. Saving your work often is standard good practice that minim
the amount of work you might lose if you encounter a problem with software, hardware, or a
network connection.

• Maintain on your PC separate folders for in-progress and published configuration files.

• Archive on your PC each configuration file that you publish to the CTE. If someone accidenta
overwrites the “good” configuration file on the CTE, you can retrieve it from your PC.

• After you complete work on a configuration file and want to put it into production, be sure to publ
the configuration file to the CTE by using theFile > Publish Configuration command in Design
Studio.
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The Design Studio application requires the following:

• Windows 95, Windows 98/ME, Windows 2000, or Windows NT 4.0 with Service Pack 6.

• At least 10 MB of disk space.

• At least 128 MB of RAM; 256 MB is recommended.

• Internet Explorer version 5.0 or higher or Netscape version 4.01 or higher.

• Java 2 Runtime Environment (JRE), Standard Edition, version 1.2.2 (available from
http://www.javasoft.com or the Design Studio CD-ROM).

• A VGA color monitor with a graphics card capable of showing 16-bit color or higher. A minimu
screen resolution of 640 x 480. Recommended resolution is 1280 x 1024.

• Network connection to the Cisco CTE 1400.

Supported Formats
The Cisco CTE 1400 and Design Studio support the formats most commonly used for websites a
wireless devices.

Website content in the following formats is supported:

• HTML versions 4.0, 3.2, and 2.0

• XHTML versions 1.1 and 1.0

• XML version 1.0

• XSL version 1.0

• GIF, JPEG, BMP, and WBMP image formats

Wireless device microbrowsers do not support all content types. The Cisco CTE 1400 passes the
following content to a wireless device as is:

• Binary data, such as audio, video, and PDF files

• Java applets, scripts, plug-ins, and custom objects
3
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Supported Formats
Table 1 lists the destination devices supported by the Cisco CTE 1400.

Table 1 Supported Devices

Category Vendor and Model Models Tested

cHTML(1)1

1. cHTML = Compact HTML

Casio Cassiopeia EM-500

Compaq iPAQ iPAQ

Hewlett-Packard Jornada Jornada 525, Jornada 545, Jornada 720

Psion Revo Plus Revo Plus

cHTML(2) Research in Motion (all models) Blackberry, RIM 950

IP phones Cisco IP phone (all models) all models

Palm HTML Handspring Visor (all models) Visor, Visor Deluxe, Visor Edge, Visor Neo,
Visor Platinum, Visor Prism, Visor Pro

Palm VII Palm VII

Sony CLIÉ CLIÉ PEG-S300

VoiceXML BeVocal, Tellme BeVocal, Tellme

WML 2

version 1.1
(WAP-enabled
phones)

2. WML = Wireless Markup Language

Alcatel (all models) OneTouch 701

Audiovox CDM-9000 CDM-9000

Benefon (Benefon Q) Benefon Q

Ericsson (all models) R320, R380, R380s, R520, T20, T29, T39

Motorola (all models) 250, 260, A008, P7389, P8767, StarTac v.50
(V2288 is not tested)

Nokia (all models) 6210, 7110, 9110, 9210

Panasonic (all models) GD93

Philips (all models) Azalis, Ozeo, Xenium

Samsung (all models) SCH-850, SGH-N100

Sanyo (all models) SCP-4500

Siemens (all models) S35, S45, Sl45

(IC35 is not tested)

Sony (all models) CMD-Z5
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Upgrading the Cisco CTE 1400 and Design Studio
Before you upgrade a CTE, record its network and DNS parameters. You will need to reconfigure
CTE after you upgrade it.

To upgrade to the latest release, perform these steps:

Step 1 From a PC where Design Studio is already installed, go to the URL
http://www.cisco.com/cgi-bin/tablebuild.pl/cte-3des and then click the heading “Cisco CTE 1400
Software.”

Step 2 Download the upgrade files, one for the CTE and one for Design Studio.

The download process copies the following files to your PC:

– CTEserver116 (the CTE upgrade)

– CTEDesignStudio116.exe (the Design Studio upgrade)

Step 3 Start the already installed version of Design Studio.

Step 4 From the Design Studio File menu, chooseUpgrade CTE 1400.

Note You must upgrade the CTE before upgrading Design Studio.

Step 5 In the Open dialog box, navigate toCTEserver116 and clickOpen.

Design Studio uploads and installs the CTE upgrade file.

Step 6 Exit Design Studio.

Step 7 In the CTE console, reset the CTE network and DNS parameters.

Step 8 Exit Design Studio.

Step 9 To install the upgrade to Design Studio, double-clickCTEDesignStudio116.exe.

Step 10 Restart Design Studio.

Note Design Studio automatically upgrades configuration files created in release 1.1.5 to the
release 1.1.6 format. When you attempt to open a configuration file, Design Studio gives yo
the choice of overwriting the old file or saving it to a different name.

New Features in Release 1.1.6
The following sections describe new features in Cisco CTE 1400 and Design Studio release 1.1.

• Monitoring the Performance of the Cisco CTE 1400, page 6

• Viewing the Cisco CTE 1400 Server Log, page 6

• Configuring the Cisco CTE 1400 to Proxy All Web Pages, page 7

• Directing Cisco CTE 1400 Requests through a Proxy Server, page 7

• Previewing VoiceXML Support, page 8
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• Dividing a Web Page into Multiple Pages, page 9

• Working with Frames, page 11

• Replacing an Image with ALT Attribute Text, page 12

• Manually Configuring XPath Expressions, page 12

Monitoring the Performance of the Cisco CTE 1400
You can now monitor the performance of the CTE. You use the CTE console to enable and disab
logging of system performance information and to view the information collected during the loggi
By reviewing the information provided, you can track unusual changes which can affect the stability
performance of the CTE.

The information provided includes the following:

• How long the CTE has been running

• System load averages for the past 1, 5, and 15 minutes

• The amount of total, used, and free memory

• The number of received connections, inbound/outbound requests, and failed requests

• A list of listening and non-listening sockets

• The number of requests from each type of device

Running the performance monitor degrades the performance of the CTE.

To monitor and view performance information, perform these steps:

Step 1 From the CTE console, type20 (Enable/Disable System Performance Monitoring) and pressEnter.

Step 2 Answeryes to the prompt to start the monitoring and pressEnter.

Step 3 When you are ready to view performance information, type21 (View System Performance Information)
and pressEnter.

To stop the monitoring, perform these steps:

Step 1 From the CTE console, type20 (Enable/Disable System Performance Monitoring) and pressEnter.

Step 2 Answerno to the prompt to stop the monitoring and pressEnter.

Viewing the Cisco CTE 1400 Server Log
The CTE logs informational, warning, and error messages related to the interactions between th
and Design Studio. You can view the Server Log from Design Studio and you can change the log
level in the CTE console so that all messages or only server version information is displayed in th
6
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To change the logging level, perform these steps:

Step 1 From the CTE console, type17 (...Enable/Disable Verbose Mode) and pressEnter.

Step 2 Typev to toggle verbose mode on and off.

To view the Server Log from Design Studio, perform these steps:

Step 1 From the File menu, chooseView Server Log.

Step 2 To refresh the display, clickRefresh.

Step 3 To exit the window, clickDone.

Configuring the Cisco CTE 1400 to Proxy All Web Pages
By default, the CTE proxies only the web pages it has transformed in order to prevent access to pro
servers that are on the same subnet as the CTE. You can use the CTE console to override the d
behavior so that the CTE proxies all web pages: Select option12 (Enable Unrestricted Proxy Support)
and enteryesto the prompt. For more information, see the“Important Security Information” section on
page 2.

Directing Cisco CTE 1400 Requests through a Proxy Server
You can specify that CTE requests for web pages go through a proxy server or use a direct conne
For example, you can specify a proxy server for nonsecure requests and use a direct connection
secure requests.

To specify a proxy server for HTTP (nonsecure requests), perform these steps:

Step 1 From the CTE console, type8 (Set Proxy) and pressEnter.

Step 2 Enter the HTTP proxy IP address and pressEnter.

To specify a proxy server for HTTPS (secure requests), perform these steps:

Step 1 From the CTE console, type9 (Set Secure Proxy) and pressEnter.

Step 2 Enter the HTTPS proxy IP address and pressEnter.
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To disable a proxy server, perform these steps:

Step 1 From the CTE console, type8 (Set Proxy) or9 (Set Secure Proxy) and pressEnter.

Step 2 Specify0 as the IP address and pressEnter.

Previewing VoiceXML Support
Design Studio release 1.1.6 contains a preview of VoiceXML support. This preview enables you to c
a transformation for one static web page that a caller can then access by phone through the BeVo
Tellme VoiceXML service providers. When a caller dials the number you set up with a VoiceXML
service provider, the service provider sends a request for the page through the CTE. The CTE trans
the page to VoiceXML and delivers the page to the service provider, which then reads the page t
caller.

To set up a VoiceXML transformation, perform these steps:

Step 1 Contact either BeVocal or Tellme to set up an account and a portal for the web page.

The service provider will ask you to specify a user name, password, IP address, and port numbe
service provider will give you a phone number for your VoiceXML portal.

Step 2 Create a project in Design Studio and add the web page you want to transform to VoiceXML.

Note The page must be available on the internet. VoiceXML service providers cannot access
intranet content.

Step 3 Specify a page identifier for the page.

Step 4 Use Design Studio transformation rules to select the content you want callers to hear when they re
the page from BeVocal or Tellme.

Note All Configure dialog boxes now include VoiceXML in the list of Device Types. Be sure to
choose VoiceXML in the Device Type list when you configure the rules.

The content you select must contain static content; dynamic content is currently not supported. Yo
include links, but a caller will not be able to select and follow links in this preview release of VoiceXM

Step 5 Save the configuration file and publish it to the CTE.

Step 6 Dial the phone number for the VoiceXML portal to hear the transformed content.
8
Release Notes for Cisco CTE 1400 and Design Studio Release 1.1.6

78-13086-02



New Features in Release 1.1.6

ltiple
e into

t you
ide.

.

Dividing a Web Page into Multiple Pages
Since web pages can contain more information than is reasonable to send to a device with a
microbrowser, you can use Design Studio to manually paginate a web page, effectively creating mu
views of the page. For example, if a page contains four categories of links, you can divide the pag
four smaller pages, each containing one category of links.

To paginate a page, you must first apply a Paginate Anchor rule to the link that points to the conten
want to divide. You then apply multiple Pagination Identifier rules to the page that you want to div
The Pagination Identifier rules map each link to a particular view of the page.

To create links to the page you want to paginate, follow these steps:

Step 1 In the XHTML source view, right-click thea element that contains the link to the page you want to
paginate.

Step 2 ChoosePaginate Anchor from the shortcut menu.

The Configure: Paginate Anchor Rule dialog box appears.

Step 3 Choose each device type to which you want to apply the rule.

Step 4 In the Number of Manual Paginations text box, enter the total number of links you want to create

This number corresponds to the number of views you want to create for one web page.

Step 5 Click the Insert Element tab.

The Insert Element tab appears.
9
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Use the Insert Element tab to specify the text you want to appear before, after, or instead of the ex
link. The text you insert should uniquely identify each view of the destination page.

Step 6 Select the location for the inserted text, as follows:

– To put the inserted text before the existing link, selectBefore Anchor’s Children.

– To put the inserted text after the existing link, selectAfter Anchor’s Children .

– To replace the existing link, selectReplace all Children.

Step 7 In the text box for tab 1, enter the text you want to display for the link.

For example, if you want the word “Overview” followed by abr  element, type:Overview<br/> .

Step 8 Click tab 2 and enter the text and any XHTML elements for the link.

Step 9 Repeat the preceding step for each tab.

Step 10 Click Done.

To define a view of a page, follow these steps:

Step 1 After you create links to a page, click theBrowse tab.

The Browse tab displays the link text you just created.

Step 2 Click one of the links you created.

Step 3 Click Add Page to Project.

Step 4 Right-click anywhere in the XHTML source view.

Step 5 ChoosePagination Identifier  from the shortcut menu.

The Identify Page dialog box appears.

Step 6 In the Pagination Number text box, enter the number that corresponds to the tab number where 
specified the link text to this view.
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For example, to define the view for the “Overview” page you identified as “1” when configuring th
Paginate Anchor rule, enter1 in the Pagination Number text box.

Step 7 Click Done.

Step 8 Apply a Tag Contains rule to uniquely identify this view.

For example, apply a Tag Contains rule to a text element that appears just in this view.

Step 9 Apply a Select rule to the element that contains the text you want to appear in this view.

For example, if the text you want to appear in this view is contained in a table, apply the Select r
the table.

Step 10 Repeat steps 2 through 9 for each view you want to create.

Note To return to the page that contains the links to each view, click the page link in the projec
tree. The page displays in the Browse tab where you can then click any link you have create

Working with Frames
When you navigate to a page that contains frames, previous releases of Design Studio gave you
choice of transforming the individual frames or using the content of thenoframes element. You now
have a third option: redirect the page to one of the frames. This option enables you to eliminate 
intermediate page, freeing a wireless device user from having to click through it.

To redirect a page to one of its frames, perform these steps:

Step 1 When you navigate to a page and see the “This Page Contains Frames” message, clickAdd Page to
Project to add the page to your project.

Step 2 Create an identifier for the page.

Step 3 In the project tree, click a device type for which you want to create a No Frames rule.

Step 4 Right-click the XHTML source view.

Step 5 ChooseFrames from the shortcut menu.

Note The Frames command was previously named NoFrames.

Step 6 Choose whether to apply the rule to all pages in this project or just this page.

Step 7 SelectRedirect to frame.

Step 8 From the drop-down menu, choose the destination frame name.

Step 9 Choose each device type to which you want to apply the rule.

Step 10 Click Done.

Design Studio transforms the page, includes the message “This page will redirect to,” and include
frame name.
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Replacing an Image with ALT Attribute Text
In previous releases of Design Studio, you had to use the Modify rule to replace an image with alte
text. Design Studio now has a new rule, named Image ALT, designed specifically to handle imag

To use alternate text instead of an image, perform these steps:

Step 1 In the XHTML source view, right-click theimg element that has the alternate text you want to use
instead of the image.

Step 2 ChooseImage ALT  from the shortcut menu.

Step 3 Choose whether to apply the rule to all pages in this project or just this page.

Step 4 Choose each device type to which you want to apply the rule.

Step 5 Click Done.

Note You can apply the Image ALT rule to multiple elements, such as to all images on a page. In
the Configure: Image ALT Rule dialog box, click theimg element in the Path to Selected
Element area, and then change the depth and position settings.

Manually Configuring XPath Expressions

Note The following new feature is intended only for users familiar with XSL.

You can now fine-tune the XPath expression formed by the other settings in the Configure Path d
boxes. The Configure Text Path dialog box and the Configure Element Path dialog box contain a
area where you can configure an XPath expression.

To manually configure an XPath expression, perform these steps:

Step 1 In the Configure Text Path or Configure Element Path dialog box, set the depth, position, etc. op

Step 2 SelectManually Configure Element.

Step 3 Click Reload to view the current XPath expression for the node.

Step 4 Edit the XPath configuration in the text box.

Design Studio alerts you if you enter invalid syntax for the XPath.

Step 5 Click Done.
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Open and Resolved Caveats in Release 1.1.6
This section contains the following topics:

• Open Caveats in the Cisco CTE 1400, page 13

• Open Caveats in Design Studio, page 14

• Resolved Caveats in the Cisco CTE 1400, page 15

• Resolved Caveats in Design Studio, page 16

Open Caveats in the Cisco CTE 1400
This section describes the additional known limitations in Cisco CTE 1400 release 1.1.6.

• CSCdv61558

The default browser on a Palm device cannot handle more than two consecutive redirect req
When that occurs, the Palm device displays the message “You’ve been redirected too many 

Workaround:  Use the Blazer browser instead of the Elaine browser for Palm devices.

• CSCdv61681

When a Palm device receives a URL that contains “[]” (square brackets), it displays an error
message with error code iNet 141B. In a future release, the CTE will transform the URL so tha
page renders on the Palm.

Workaround : Use Design Studio to create a transformation rule that removes the portion of t
URL contained in square brackets.

• CSCdu87807

Although you can specify Dynamic Host Configuration Protocol (DHCP) as the boot protocol
(option 2 in the CTE console), the CTE works only with DHCP servers that are configured to re
a host name.

Workaround:  None.

• CSCdv61686

Web sites that are coded in WML do not pass through the CTE if the URL to the site is relati
the URL to the WML-coded site is absolute, the site content passes through the CTE.

Workaround : None.

• CSCdv61609

The CTE does not retain a backup version of a configuration file. When you publish a configura
file, it overwrites the previous configuration file.

Workaround:  Archive configuration files on your PC.

• CSCdv61689

When CTE console option 9 (Set Secure Proxy) is disabled, SSL/HTTPS sessions are conver
HTTP and are, thus, unsecure. When secure proxy is set, the CTE should instead drop any
server-side connections to HTTPS content.

Workaround:  Enable the Set Secure Proxy option.
13
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• CSCdv61691

Input fields that are created with thetextarea element do not work on WAP devices.

Workaround: Use the modify rule to change thetextarea element to aninput element. Be sure to
delete anytextarea attributes, such asrows andcols, that are not valid forinput  elements.

• CSCdv64990

Design Studio allows you to publish a configuration file that does not contain any identifier ru
Without an identifier rule, a configuration file matches all pages. As a result, a wireless device
can retrieve any page through the CTE, even if console option 12 (Enable Unrestricted Proxy
Support) is disabled.

Workaround:  Include at least one identifier rule per page in a configuration file.

Open Caveats in Design Studio
This section describes the additional known limitations in Design Studio release 1.1.6.

• CSCdv61702

Two consecutive upgrades to the CTE cause Design Studio to hang.

Workaround:  Restart Design Studio after you upgrade the CTE.

• CSCdv61706

You cannot select in the browser view content that is generated by a style sheet.

Workaround:  Select the content in the XHTML source view.

• CSCdv61707

Design Studio supports only the XSL and XHTML namespaces. If you import an XSL style sh
that contains references to other namespaces, the console displays a message such as the fo
“Unsupported stylesheet operation: no such prefix: rdf.”

Workaround:  Remove references to unsupported namespaces in XSL style sheets.

• CSCdv64983

Design Studio does not support XSL style sheets that have anxsl:import  element followed by an
xsl:include element. If you attempt to add a page to an XML project that uses such a style shee
CTE console displays the error MalFormedURLException and Design Studio will need to be
stopped and restarted.

Workaround:  Combine the XSL style sheet referenced by thexsl:include element with the style
sheet referenced by thexsl:import  element. Design Studio supports thexsl:import  element.

• CSCdv64986

Design Studio cannot save a configuration file that contains an XML page with aCDATA  section.

Workaround:  You can use any of the following workarounds:

– Remove anyCDATA  sections from the XML page.

– Create a temporary XML page that does not containCDATA  sections. Create a Tag Contains
identifier rule for the page.
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• CSCdv64987

Design Studio does not correctly store the name of Paginate Identifier rules in a configuration
When you open a configuration file, Paginate Identifier rules might not have a name.

Workaround: When you open a configuration file that contains Paginate Identifier rules, verify t
the rules have names. If they do not, edit the rules and enter a name for them.

Resolved Caveats in the Cisco CTE 1400

Note The *** in this section indicate that the caveat was reported and resolved after release 1.1.5.

This section describes the caveats resolved in Cisco CTE 1400 release 1.1.6.

• CSCdu87787

The CTE assumed that the network mask set for the second network interface card (eth1) is the
for the first network interface card (eth0).

Resolution: You can set the network mask for eth1 by using the CTE console option3 (Set
Networking Parameters) as described in theCisco Content Transformation Engine 1400
Configuration Note.

• CSCdv61555***

WML devices that use the pre-3.1 version of the Openwave Mobile Browser (UP.Browser),
sometimes displayed a Form Compilation Error when attempting to handle forms.

Resolution: The CTE correctly handles the forms on the earlier versions of the UP.Browser.

• CSCdv61567***

When browsing on a Palm VII, clicking a Submit button sometimes resulted in the display of 
same page.

Resolution: The correct page is now loaded.

• CSCdu87815

Decimal character references below 160 will be encoded differently in release 1.1.6. The enco
change will affect any rules that include these special characters.

Resolution:The encoding for decimal character references has changed. Design Studio conver
encoding when you open a release 1.1.5 configuration file in release 1.1.6.

• CSCdu87822

The CTE could not access a website from behind a proxy firewall. To your website, the CTE
appeared as a browser, like Internet Explorer or Netscape. If you set up your website to use a
server, the CTE was unable to access pages from your website.

Resolution: The CTE now supports proxy servers, as described in the“Directing Cisco CTE 1400
Requests through a Proxy Server” section on page 7.

• CSCdu87918

If you configure a cache engine to cache pages from the CTE, you can log in to the CTE but ca
retrieve web pages from it. This problem has been observed only with the Cisco cache engin

Resolution: Set your cache engine to bypass mode. Review the configuration note for your c
engine for instructions.
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• CSCdv61599***

Unless option 4 (Set Masquerade Host) was set in the CTE console, you could not follow link
WAP-enabled phones that use WML.

Resolution: You no longer have to set a masquerade host to follow links on WAP-enabled ph
that use WML.

• CSCdu87847

The CTE sometimes did not correctly handle a form on WML and IP phones if the form had an in
type of “hidden” and a value that contained the "%" character.

Resolution: The CTE correctly handles the forms.

• CSCdv61604***

Some servers return a content-type value of “text/plain” for XML documents. Because the CT
chose a parser based on the content-type value, the wrong parser was used for XML docum

Resolution: The CTE now chooses a parser based on the filename extension, rather than the
content-type value.

• CSCdv61612***

A CTE attempting to perform more than two transformations simultaneously will successfully
handle only one of the transformations and will not respond to the other requests.

Resolution: The CTE correctly handles multiple simultaneous transformations.

Resolved Caveats in Design Studio

Note The *** in this section indicate that the caveat was reported and resolved after release 1.1.5.

This section describes the resolved caveats in release 1.1.6 of Design Studio.

• CSCdu87874

When uploading a configuration file to the CTE, Design Studio appeared to hang.

Resolution: Design Studio displays a progress bar, so you can monitor the progress of the up

• CSCdv61624***

When you saved a configuration file, Design Studio did not check for a file of the same name in
directory and display the Save As dialog box.

Resolution: Design Studio displays the Save As dialog box when you attempt to save a
configuration file with a duplicate file name.

• CSCdv61628***

If you attempted to browse to a page while Design Studio was publishing a configuration file to
CTE, Design Studio displayed a message that there was a problem with the upload although
completed successfully.

Resolution: Design Studio no longer displays an error message when the upload completes
successfully.
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• CSCdu87913

A page sometimes rendered differently in the Edit tab and the Browse tab. This problem occ
when you created a rule with the Match Element Name field not selected and the Position to M
option set to a range. Design Studio incorrectly calculated the range in the Edit tab.

Resolution: Pages now render correctly in the Edit tab.

• CSCdv61635***, CSCdv61637***

Design Studio sometimes worked incorrectly when you attempted to save a configuration file
some cases, a Java NullPointerException occurred; in other cases, Design Studio incorrectly
interpreted a filename as invalid.

Resolution: Design Studio now correctly saves configuration files.

• CSCdu87916

Design Studio allowed thep element to be hierarchical. Any rule associated with ap element may
not have resulted in a correct transformation.

Resolution:Design Studio no longer allows thep element to be hierarchical. Design Studio correc
the transformation rules for thep element when you open a 1.1.5 configuration file in release 1.1

• CSCdv61639***

Design Studio did not correctly display some UTF-8 characters, such as the bullet character.

Resolution: Design Studio correctly displays the special characters.

• CSCdu87925

The Dial rule could not prepend a "9" or other number to access an external number.

Resolution: The Configure: Dial Rule dialog box now includes a text box for entering a phone
number prefix.

• CSCdv61642***

Clicking the Close button in the Save As dialog box did not close the dialog box and displaye
Conflict message box.

Resolution: The Close button in the Save As dialog box works correctly.

• CSCdv61652***, CSCdv61661***

The Find dialog box did not work correctly when the search string included a space or the follow
special characters: /, <, >, =.

Resolution: The Find dialog box handles spaces and special characters.

• CSCdv61664

Design Studio might not display the content of anoframes element in the browser view.

Resolution: Design Studio always displays the content of anoframes element.

• CSCdv61667***

Design Studio incorrectly calculated the range values in the Configure Element dialog boxes

Resolution: Design Studio correctly calculates the range values.
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CTE Console Changes
The Review and Commit option has changed from 8 to31. The Restart/Shutdown option has changed
from 9 to32.

Path to Selected Element Area
The Path to Selected Element area in the Identify Page dialog box and all Configure: Rule dialog b
has changed. Previously the Path to Selected Element area contained a button for each path ele
Now the path elements are presented in a list as shown inFigure 1.

Figure 1 Path to Selected Element Area

Open Caveats in Release 1.1.5

Open Caveats in the Cisco CTE 1400
This section describes the known limitations in Cisco CTE 1400 release 1.1.5.

• CSCdu87742

The CTE supports HTTP Basic Authentication only.

Workaround:  None. A future release of the CTE will support Digest Authentication. There is 
planned support for Windows NT Challenge/Response Authentication (also referred to as NT

• CSCdu87770

The CTE does not support web pages that exceed 256 KB.

Workaround: None. In a future release, the CTE console will allow you to configure the suppor
page size.
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• CSCdu87787

The CTE assumes that the network mask set for the second network interface card (eth1) is the
for the first network interface card (eth0).

Workaround : None.

• CSCdu87802

The CTE currently supports only strong (128-bit) Secure Sockets Layer (SSL) encryption for
incoming connections.

Workaround:  None.

• CSCdu87807

Although you can specify Dynamic Host Configuration Protocol (DHCP) as the boot protocol
(option 2 in the CTE console), the CTE currently works only with DHCP servers that are configu
to return a host name.

Workaround:  To use DHCP with the CTE, configure your DHCP server to return a host name
Alternatively, reserve an IP address for the CTE. In a future release, the CTE will fully suppo
DHCP.

• CSCdu87815

Decimal character references below 160 will be encoded differently in the next release. The
encoding change will affect any rules that include these special characters.

Workaround:  None.

• CSCdu87822

The CTE cannot access a website from behind a proxy firewall. To your website, the CTE ap
as a browser, like Internet Explorer or Netscape. If you set up your website to use a proxy se
the CTE is unable to access pages from your website.

Workaround:  Do not force proxy use. Release 1.1.6 of the CTE removes this limitation.

• CSCdu87829

The masquerade IP address (option 4 in the CTE console) defaults to an invalid value.

Workaround:  Use option 4 in the CTE console to set the CTE masquerade IP address to the
appropriate value. For information, refer to theCisco Content Transformation Engine 1400
Configuration Note.

• CSCdu87834

The CTE processes web pages only from servers that return a valid content type, either “text/h
or “text/xml.” The CTE does not transform a web page with any other content type and passes
wireless devices as is.

Workaround:  Set up your server to return a supported content type.

• CSCdu87847

The CTE may not correctly handle a form on WML and IP phones if the form has an input type
“hidden” and a value that contains the "%" character.

Workaround:  None. Release 1.1.6 of the CTE fixes this problem.
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• CSCdu87856

You must choose the type of encoding used for web pages from the CTE console.

Workaround: The CTE uses Latin-1 encoding by default, which will work for most pages that a
not encoded in Unicode Transformation Format-8 (UTF-8). We recommend that you use Lati
encoding for HTML-based pages and UTF-8 encoding for XML documents. You can also cho
raw, ASCII, or macro encoding.

Open Caveats in Design Studio
This section describes the known limitations in Design Studio release 1.1.5.

• CSCdu87868

The scroll bars in the XHTML source view are incorrect. This problem occurs as the result of
known issue with JRE/JDK version 1.2.2 that will be resolved in a future release.

Workaround:  Redisplay the XHTML source view by opening and closing a node in the tree.

• CSCdu87874

When uploading a configuration file to the CTE, Design Studio appears to hang.

Workaround:  Wait until Design Studio completes the upload. A future release of Design Stud
will contain a progress bar and performance enhancements.

• CSCdu87887

You cannot rename a page or project in Design Studio.

Workaround:  Support for renaming pages and projects will be included in a future release.

• CSCdu87891

The drop-down menus in the Log in to the Cisco CTE 1400 dialog box do not retain previous
selected values. For example, if you change the value of the User Name field, the previously sel
value no longer appears in the menu. This problem occurs as the result of a known issue wit
JRE/JDK version 1.2.2.

Workaround:  Enter a value.

• CSCdu87893

You cannot delete or edit multiple rules simultaneously by selecting them in the Transformati
Rules or Identifier Rules lists and then clicking the Delete or Edit button. Design Studio perfo
the command only on the last rule selected.

Workaround:  Delete or edit the rules individually.

• CSCdu87896

After applying a rule or clicking a tab, the Edit or View Original tab is blank.

Workaround:  Change to a different tab and the page will render.

• CSCdu87903

When you click a link in either the Edit tab or View Original tab, Design Studio sometimes displa
the link destination instead of selecting the link.

Workaround:  Click the Browse tab, click the previously selected tab, and then select the link
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• CSCdu87906

After the following sequence of steps, Design Studio is unable to load additional web pages:

a. Start Design Studio.

b. Create a new project.

c. Browse towww.yoursite.com.

d. Add a page to the project.

e. Remove the page from the project.

f. Browse towww.yoursite.comn. (Notice the spelling at the end of the URL.)

Workaround: Save the project, exit Design Studio, and restart Design Studio. This problem wil
fixed in a future release.

• CSCdu87911

You cannot save a configuration file (.cte) with an extension that contains a "/" or "\".

Workaround:  Remove the slash from the filename.

• CSCdu87913

A page renders differently in the Edit tab and the Browse tab. This problem occurs when you c
a rule with the Match Element Name field not selected and the Position to Match option set t
range. Design Studio incorrectly calculates the range in the Edit tab.

Workaround:  View the page in the Browse tab, which renders the page in the same way that
CTE will transform it.

• CSCdu87916

Design Studio allows thep element to be hierarchical. Any rule associated with ap element may
not result in a correct transformation.

Workaround:  None. Release 1.1.6 of the CTE correctly flattens thep element.

• CSCdu87918

If you configure a cache engine to cache pages from the CTE, you can log in to the CTE but ca
retrieve web pages from it.

Workaround:  Do not configure a cache engine to cache pages from the CTE. A future releas
the CTE will support cache engines.

• CSCdu87920

After browsing to a page in Design Studio, the URL listed in the Address field is incorrect. Th
problem occurs if the server where the web page originates is returning a content type other
“text/html” or “text/xml.”

Workaround:  Set up your server to return a supported content type.

• CSCdu87925

The Dial rule cannot prepend a "9" or other number to access an external number.

Workaround:  None. Release 1.1.6 of the CTE supports prepended numbers.
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Additional Documentation
The following documents are available for the Cisco CTE 1400 and Design Studio:

• Cisco CTE 1400 and Design Studio Quick Start Guide

• Cisco CTE 1400 Hardware Installation Guide

• Cisco Content Transformation Engine 1400 Configuration Note

• Design Studio User Guide

Obtaining Documentation
The following sections explain how to obtain documentation from Cisco Systems.

World Wide Web
You can access the most current Cisco documentation on the World Wide Web at the following U

http://www.cisco.com

Translated documentation is available at the following URL:

http://www.cisco.com/public/countries_languages.shtml

Documentation CD-ROM
Cisco documentation and additional literature are available in a Cisco Documentation CD-ROM
package, which is shipped with your product. The Documentation CD-ROM is updated monthly and
be more current than printed documentation. The CD-ROM package is available as a single unit
through an annual subscription.

Ordering Documentation
Cisco documentation is available in the following ways:

• Registered Cisco Direct Customers can order Cisco product documentation from the Networ
Products MarketPlace:

http://www.cisco.com/cgi-bin/order/order_root.pl

• Registered Cisco.com users can order the Documentation CD-ROM through the online Subscr
Store:

http://www.cisco.com/go/subscription

• Nonregistered Cisco.com users can order documentation through a local account representa
calling Cisco corporate headquarters (California, USA) at 408 526-7208 or, elsewhere in Nor
America, by calling 800 553-NETS (6387).
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Documentation Feedback
If you are reading Cisco product documentation on Cisco.com, you can submit technical comme
electronically. ClickLeave Feedbackat the bottom of the Cisco Documentation home page. After yo
complete the form, print it out and fax it to Cisco at 408 527-0730.

You can e-mail your comments to bug-doc@cisco.com.

To submit your comments by mail, use the response card behind the front cover of your docume
write to the following address:

Cisco Systems
Attn: Document Resource Connection
170 West Tasman Drive
San Jose, CA 95134-9883

We appreciate your comments.

Obtaining Technical Assistance
Cisco provides Cisco.com as a starting point for all technical assistance. Customers and partner
obtain documentation, troubleshooting tips, and sample configurations from online tools by using
Cisco Technical Assistance Center (TAC) Web Site. Cisco.com registered users have complete ac
the technical support resources on the Cisco TAC Web Site.

Cisco.com
Cisco.com is the foundation of a suite of interactive, networked services that provides immediate,
access to Cisco information, networking solutions, services, programs, and resources at any time
anywhere in the world.

Cisco.com is a highly integrated Internet application and a powerful, easy-to-use tool that provid
broad range of features and services to help you to:

• Streamline business processes and improve productivity

• Resolve technical issues with online support

• Download and test software packages

• Order Cisco learning materials and merchandise

• Register for online skill assessment, training, and certification programs

You can self-register on Cisco.com to obtain customized information and service. To access Cisco
go to the following URL:

http://www.cisco.com
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Technical Assistance Center
The Cisco TAC is available to all customers who need technical assistance with a Cisco product,
technology, or solution. Two types of support are available through the Cisco TAC: the Cisco TAC
Web Site and the Cisco TAC Escalation Center.

Inquiries to Cisco TAC are categorized according to the urgency of the issue:

• Priority level 4 (P4)—You need information or assistance concerning Cisco product capabiliti
product installation, or basic product configuration.

• Priority level 3 (P3)—Your network performance is degraded. Network functionality is noticea
impaired, but most business operations continue.

• Priority level 2 (P2)—Your production network is severely degraded, affecting significant aspe
of business operations. No workaround is available.

• Priority level 1 (P1)—Your production network is down, and a critical impact to business operati
will occur if service is not restored quickly. No workaround is available.

Which Cisco TAC resource you choose is based on the priority of the problem and the conditions
service contracts, when applicable.

Cisco TAC Web Site

The Cisco TAC Web Site allows you to resolve P3 and P4 issues yourself, saving both cost and time. The
site provides around-the-clock access to online tools, knowledge bases, and software. To access
Cisco TAC Web Site, go to the following URL:

http://www.cisco.com/tac

All customers, partners, and resellers who have a valid Cisco services contract have complete acc
the technical support resources on the Cisco TAC Web Site. The Cisco TAC Web Site requires a
Cisco.com login ID and password. If you have a valid service contract but do not have a login ID
password, go to the following URL to register:

http://www.cisco.com/register/

If you cannot resolve your technical issues by using the Cisco TAC Web Site, and you are a Cisco
registered user, you can open a case online by using the TAC Case Open tool at the following U

http://www.cisco.com/tac/caseopen

If you have Internet access, it is recommended that you open P3 and P4 cases through the Cisc
Web Site.

Cisco TAC Escalation Center

The Cisco TAC Escalation Center addresses issues that are classified as priority level 1 or priori
level 2; these classifications are assigned when severe network degradation significantly impacts
business operations. When you contact the TAC Escalation Center with a P1 or P2 problem, a Cisc
engineer will automatically open a case.

To obtain a directory of toll-free Cisco TAC telephone numbers for your country, go to the followin
URL:

http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml
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Before calling, please check with your network operations center to determine the level of Cisco su
services to which your company is entitled; for example, SMARTnet, SMARTnet Onsite, or Netw
Supported Accounts (NSA). In addition, please have available your service agreement number an
product serial number.
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